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Important information
Before you install and use your SMART Board® 800 series interactive whiteboard, read and
understand the safety warnings and precautions in this guide. These safety warnings and precautions
describe the safe and correct operation of your interactive whiteboard and its accessories, helping
you to prevent injuries and equipment damage. Ensure that your interactive whiteboard system is
always being used correctly.

N   NOTE

In this document, the term “interactive whiteboard” refers to your interactive whiteboard and its
accessories and options.

Safety warnings and cautions
W  WARN ING

l Ensure that any cables extending across the floor to your SMART product are properly
fastened together andmarked to avoid a trip hazard.

l To reduce the risk of fire or electric shock, do not expose your SMART product to rain or
moisture.

l Refer to the safety warnings and precautions published by the projector manufacturer. Do not
stare (or allow children to stare) directly into the projector’s beam of light.

l Do not touch (or allow children to touch) the projector because it can become extremely hot
during normal operation.

l Do not stand (or allow children to stand) on a chair to touch the surface of your SMART
product. Instead, safely fix the product at the appropriate height on a wall or use a SMART
height-adjustable floor stand.

l Do not climb (or allow children to climb) on a wall- or stand-supported
SMART Board interactive whiteboard.
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l Two people are required to safely mount your interactive whiteboard because it is too heavy
for one person to safely maneuver. When you and your assistant lift your interactive
whiteboard, support its weight at the bottom, avoiding the corner cameras, and balance the
top with your other hands.

l The weight of the interactive whiteboard is approximately 52 lb. (23.7 kg) for the
SMART Board 880 interactive whiteboard and 61 lb. (27.5 kg) for the SMART Board 885
interactive whiteboard. Check your local building codes to ensure that your wall can support
this weight, and use appropriate mounting hardware for your wall type.

l To prevent injury or product and property damage, use only themounting hardware supplied
with your SMART Board 800 series interactive whiteboard when you install your product on
drywall. Themounting hardware provided with other interactive whiteboards may not be
strong enough to support the weight of SMART Board 800 series interactive whiteboard.

l Use two wall-mounting brackets to install SMART Board interactive whiteboards with a
diagonal width of 87" (221 cm).

l For operating safety and to prevent damage to your interactive whiteboard, connect its USB
connector, or SMART connection extenders, only to a computer that has a USB compliant
interface and that bears the USB logo. In addition, the USB source computer must be
compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or ULmark(s) for
CSA/UL 60950.

l To prevent injury or product damage as a result of tipping, mount your interactive whiteboard
only on a floor stand that is certified for use with SMART Board 800 series interactive
whiteboards, such as the SMART FS670Mobile Floor Stand or SMART HAWM FS-UX
Mobile Height-Adjustable Floor Stand. Do not modify your interactive whiteboard or the floor
stand tomake them compatible.

l Move a floor stand-supported SMART Board interactive whiteboard with care. Sudden stops,
excessive force and uneven surfaces may cause the product to overturn.

C   CAUT ION

l If you’re replacing a SMART Board 500 or 600 series interactive whiteboard with the heavier
SMART Board 800 series interactive whiteboard on drywall, youmust remove the wall-
mount bracket andmounting hardware, and then install all themounting hardware and
brackets supplied with your SMART Board 800 series interactive whiteboard instead.

I M POR T A N T I N F ORMA T I ON
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l If you need to lean your interactive whiteboard against a wall, make sure that it remains in an
upright position, resting on its pen tray brackets, which are designed to sustain your
interactive whiteboard’s weight. Do not rest your interactive whiteboard on its side, on the top
of its frame or on the corners of the framewhere the cameras are located.

l Do not add any extra weight or excessive pressure to a wall-mounted interactive whiteboard
or its pen tray. SMART designed the brackets to support only the weight of your interactive
whiteboard and its accessories during normal use.

l There are no user-serviceable parts inside the pen tray.

l When transporting your SMART Board interactive whiteboard, repack it with the original
packaging. This packaging was designed with optimal shock and vibration protection.

l Do not use compressed air to clean the cameras.

l Do not allow cleaner to flow onto the IR reflectivematerial at the edges of the interactive
whiteboard frame, or into the pen tray slots.

l Do not set up and use your interactive whiteboard in an area with excessive levels of dust,
humidity or smoke.

l If your SMART Board interactive whiteboard requires replacement parts, make sure that the
service technician uses replacement parts specified by SMART Technologies.

Other precautions
If you own a SMART product other than a SMART Board 800 series interactive whiteboard, refer to
the installationmanual for your product for relevant warnings andmaintenance instructions.

I M POR T A N T I N F ORMA T I ON
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The SMART Board 800 series interactive whiteboard is themost advanced and intuitive touch
sensitive, front projection interactive whiteboard in the world, featuring SMART’s proprietary DViT®
(Digital Vision Touch) technology. Its modular and expandable hardware and software architecture
enables you to do everything you can do at your computer—open and close applications, meet with
others, create new documents or edit existing ones, visit websites, play andmanipulate video clips
andmore—just by touching the interactive surface.

When you use SMART software, you can also write over any Ink Aware application in digital ink
using a pen tray pen or your finger, and then save these notes for future reference and distribution.

Chapter 1
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Identifying the components of your 800 series
interactive whiteboard
Use the following illustration to familiarize yourself with the parts of your interactive whiteboard.

Highlights
Software
To use all the features of your interactive whiteboard described in this guide, go to
smarttech.com/downloads and ensure that you have the latest version of SMART software and
SMART Product Drivers installed on your computer.

Dual sketch capabilities
Two people can each pick up a pen and draw on the interactive surface at the same time, providing a
higher degree of interactivity.

CHA PT ER 1
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SMART Ink
The SMART Ink™ feature smoothes out the appearance of the digital ink, which improves the
legibility of your handwriting as you write over applications, websites and videos. The ink becomes an
object that you canmove andmanipulate.

Touch and gestures
You can perform mouse functions with your finger, and write and erase digital ink with a pen tray pen
or the eraser. The object awareness feature enables you to pick up a pen, and then write, select or
erase without replacing the pen.

Pen tray
The SMART Board 800 series interactive whiteboard features amodular pen tray with an intuitive
new design. As well as two pens and an eraser, pen tray buttons activate the pen’s color, the on-
screen keyboard, right-click, Orientation and Help functions.

Durable surface and dry erase
The hard-coated surface is scratch resistant, optimized for projection, compatible with dry-erase
markers and easily cleaned.

Wall-mount bracket
Wall mount brackets enable you to install your SMART Board interactive whiteboard simply and
securely.

Cables
Connect your SMART Board interactive whiteboard to your computer with the included, standard
USB cable, and to a wall outlet with the included power supply.

Security cable lock
Lock your interactive whiteboard with a security cable (not included) to help safeguard it from theft.

CHA PT ER 1
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Understanding how your SMART Board
interactive whiteboard works
Your interactive whiteboard functions as an input device for your computer, just like amouse,
enabling you to work in any application on your computer from your interactive whiteboard.

When you touch your interactive whiteboard’s surface, the four cameras located in the interactive
whiteboard’s corners detect the contact’s horizontal and vertical (or x,y) coordinates. Your computer
interprets these coordinates andmoves the pointer to the corresponding location on the interactive
whiteboard’s surface.

Other components
Using your interactive whiteboard requires two additional
components: a computer and a digital projector.

These components work together as follows:

l Your computer runs an application and sends the
image to your projector.

l Your projector casts the image onto your interactive
whiteboard.

l Your interactive whiteboard acts both as your
computer’s monitor and its input devices, that is, its
mouse and keyboard, enabling you to control any application by touching the interactive
surface.

When you install SMART Product Drivers on your computer, the touch of your finger on the
interactive surface becomes amouse click, enabling you to control your computer from your
interactive whiteboard. When you use a pen from the pen tray, the system detects which tool you’re
using. SMART Product Drivers then interacts with the computer’s mouse driver to change the pointer
to a colored pen, enabling you to write in digital ink on your desktop or any open application. When
you use the eraser, you can erase the digital ink. You can even use your finger on the interactive
whiteboard’s surface without returning the pen tray tools—automatic object awareness determines
the tool you’re using on the interactive surface. You can also save your notes to a .notebook file, or
directly into any Ink Aware application.

CHA PT ER 1
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Included parts and accessories
Your SMART Board 800 series interactive whiteboard includes the following accessories.

Pens
There are two pens included with your interactive whiteboard. Pick up a pen
and press one of the four color buttons on the pen tray (black, red, green or
blue) to change the color of digital ink you write with on the interactive whiteboard.

Eraser
The eraser is rectangular like a traditional chalkboard eraser.

Wall-mounting kit
The 32" (81.3 cm) wall-mount bracket comes with five screws and toggle bolts, enabling you to wall-
mount your interactive whiteboard simply and securely. SMART Board885 interactive whiteboards
comewith two wall-mounting kits.

USB cable
A 16' 5" (5m) USB cable enables you to connect your SMART Board 800
series interactive whiteboard to a USB receptacle on your computer.

Power supply
The SMART Board 800 series interactive whiteboard receives power from awall outlet through the
included country-specific power supply and cable.

Optional accessories
You can add a variety of optional accessories to your SMART Board 800 series interactive
whiteboard to best meet your specific needs.

You can purchase these items when you order your interactive whiteboard, or later from your
authorized SMART reseller (www.smarttech.com/us/Where). For more information about
accessories, go to www.smarttech.com/accessories.

CHA PT ER 1
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Environmental requirements
Before installing your interactive whiteboard, review the following environmental requirements.

Environmental
requirement

Parameter

Operating temperature 41°F to 95°F (5°C to 35°C)

Storage temperature -40°F to 120°F (-40°C to 50°C)

Humidity 5% to 80% relative humidity, non-condensing

Water and fluid resistance l Intended for indoor use only. Doesn’t meet any salt-spray or
water ingress requirements.

l Don’t pour or spray liquids directly onto the interactive
whiteboard or any of its sub-components. These liquids might
get into areas where they could damage sensitive electronic
components. Refer to page 30 for detailed instructions on
cleaning your interactive whiteboard.

Dust l Moderate dust. Intended for use in office and classroom
environments. Not for industrial use where heavy dust and
pollutants can causemalfunctions or impaired operation.

l Designed for pollution degree 1 (P1) as per EN61558-1, which is
defined as “No pollution or only dry non-conductive pollution.”

Conducted and radiated
emissions

EN55022/CISPR 22, Class A

Chapter 2
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Installing your SMART Board interactive
whiteboard
Follow the procedure outlined in the installation document included in your interactive whiteboard’s
box to install your interactive whiteboard. If you purchased a floor stand, wall-mount or an interactive
whiteboard system that includes a projector or other components, refer to the installation documents
included with these components. The optimal mounting height is 77" (196 cm) from the floor to the
center of the installation brackets. However, consider the general height of your user community
when you choose a location for wall-mounting your interactive whiteboard. If youmount your
interactive whiteboard too low, it might force tall people to bend over uncomfortably. If it’s too high,
other peoplemight need to reach up too far. Also remember to leave enough room on either side of the
interactive whiteboard so that you can stand beside it.

W  WARN ING

l Two people are required to safely mount your interactive whiteboard because it is too heavy
for one person to safely maneuver. When you and your assistant lift your interactive
whiteboard, support its weight at the bottom, avoiding the corner cameras, and balance the
top with your other hands.

l The weight of the interactive whiteboard is approximately 52 lb. (23.7 kg) for the 880model
and 61 lb. (27.5 kg) for the 885model. Check your local building codes to ensure that your
wall can support this weight, and use appropriate mounting hardware for your wall type.

C   CAUT ION

l If you need to lean the interactive whiteboard against a wall before youmount it, make sure it
remains in an upright position, resting on the pen tray brackets, which can sustain the weight
of the interactive whiteboard.

l Do not rest the interactive whiteboard on its side or on the top of the frame, or on the corners
where the cameras are located.

Installation tips
l Ensure the bottom of the pen tray is unobstructed at all times, because you will need to access

it if the interactive whiteboard requires service.

l Install your interactive whiteboard on a flat, plumbwall.

CHA PT ER 2
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l If you’re installing the interactive whiteboard on drywall, use all the toggle bolts supplied.
Because one of themounting bracket holes aligns with a wall stud, use appropriate hardware in
that hole instead of a toggle bolt.

l Ensure that the power supply cable is connected to the correct receptacle in the pen tray, as
shown below.

Replacing an existing interactive whiteboard on drywall
If you’re replacing a SMART Board 500 or 600 series interactive whiteboard with the heavier 800
series on drywall, youmust remove the wall-mount bracket andmounting hardware, and then install
all themounting hardware and brackets supplied with your 800 series interactive whiteboard instead.

C   CAUT ION

To help ensure that your interactive whiteboard is mounted correctly, make sure the color of the
wall-mount hanger on the back of the interactive whiteboard and the color of the wall-mount bracket
are the same.

Securing the pen tray to your interactive whiteboard
Because the pen tray is detachable, youmight want to safeguard it—and your interactive
whiteboard—by anchoring it with a security cable (not included). Underneath the pen tray, you’ll find a
lock slot that accommodates a security cable, such as a Kensington® lock.

CHA PT ER 2
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I   I MPORTANT

Securing the pen tray can provide theft deterrence for your interactive whiteboard because the
screws that secure your interactive whiteboard to the wall are located directly behind the pen tray,
and cannot be removed without first detaching the pen tray. In effect, when you secure the pen tray,
you also secure your interactive whiteboard if the security cable is tight.

g To secure the pen tray to your interactive whiteboard

1. Loop the security cable behind the pen tray brackets before you secure them to the wall.

2. Thread the lock end of the cable through the loop end of the cable.

3. Verify that the cable is tight enough that you can’t remove the pen tray while the lock is in
place, and then install the pen tray.

4. Insert the prong end of the security cable into the lock slot, and then complete the pen tray
installation by locking it.

Securing the pen tray to the brackets
Because you can remove the pen tray without tools, youmight want to securely attach it to its
brackets.

g To secure the pen tray to the brackets

Insert two No. 8/M4 screws (not included) into the holes indicated by a lock symbol on the bottom of
the pen tray.

CHA PT ER 2
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Your interactive whiteboard will be touch sensitive after you install SMART Product Drivers on your
connected computer. Perform the brief calibration and user orientation procedures (page 15) to ensure
the interactive whiteboard interprets the location of your touch accurately.

Chapter 3
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Connecting your interactive whiteboard to your
computer
Your interactive whiteboard has a USB 2.0 peripheral interface that runs at speeds of up to 12Mbps.
The unit works with full-speed USB 2.0- and USB 1.1-compliant interfaces. Your interactive
whiteboard’s main USB connection, a USB Type-B receptacle, is located on the bottom of the pen
tray. This location provides access to the USB receptacle without having to remove your interactive
whiteboard from the wall.

Connect your interactive whiteboard and your computer using the included 16' 5" (5m) USB cable.

W  WARN ING

For operating safety and to prevent damage to your interactive whiteboard, connect its USB
connector, or SMART connection extenders, only to a computer that has a USB compliant
interface and that bears the USB logo. In addition, the USB source computer must be compliant
with CSA/UL/EN 60950 and bear the CE mark and CSA and/or ULmarks for CSA/UL 60950.

g To connect your interactive whiteboard and your computer

1. Connect the included 16' 5" (5m) USB cable to a USB A receptacle on your computer.

2. Connect the other end of the cable to your interactive whiteboard’s USB B receptacle.

3. Tuck the cable into the cablemanagement slot on the bottom of the pen tray to prevent a
tripping hazard.

You can now install SMART Product Drivers.

CHA PT ER 3
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Installing SMART Product Drivers
After you install SMART Product Drivers on your computer, your SMART Board interactive
whiteboard’s surface will respond to the touch of your finger or a pen tray pen.
SMART Product Drivers includes the tools you need to control computer applications with your finger
or a pen, and to write over them in digital ink.

N   NOTE

If you don’t install SMART Product Drivers, interactive whiteboard tools such as the pens and the
eraser don’t work, but you canmove themouse pointer and perform mouse functions by touching
the interactive surface.

g To install SMART Product Drivers

1. Download theSMART Product Drivers.exe (Windows® computers) orSMART Product
Drivers.dmg (Mac computers) file to your computer from the disc or link included with your
interactive whiteboard or from smarttech.com/downloads.

N   NOTE

In most cases, SMART Product Drivers is downloaded and installed automatically when you
install SMART Notebook™ or SMART Meeting Pro™ software.

2. If it’s not already on, turn on your projector to see the projected computer image on your
interactive whiteboard.

3. Locate the installation program and follow the on-screen instructions to complete the
installation.

SMART Board Tools opens automatically.

4. If SMART Board Tools doesn’t open:

o If you have aWindows computer, select Start > All Programs >SMART
Technologies > SMART Product Drivers > SMART Board Tools

o If you have aMac computer, openMac HD, and then select Applications > SMART
Product Drivers > SMART Board Tools.app.

The Ready light in your interactive whiteboard’s pen tray turns from flashing green to solid
green and the SMART software icon appears in theWindows notification area or Mac Dock,
indicating that your interactive whiteboard is communicating successfully with SMART
Product Drivers.

CHA PT ER 3
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You can now pick up a pen from the pen tray and write over your desktop or any projected application,
and use all the other features of your SMART software. For more information on using your SMART
software, press the SMART software icon, and then select Help.

Configuring your computer settings
For optimal configuration, use the following settings for the computer connected to your interactive
whiteboard.

Recommended settings
Configure your computer’s powermanagement settings to turn off themonitor after one hour of
inactivity and to put the hard disks into standby mode after two hours. This extended period prevents
the computer from shutting down unexpectedly (for example, during presentations or meetings that
have gaps in computer activity).

Your computer will stop sending a video signal to your projector after a period of idle time, whichmay
trigger the projector to go into standby mode. Similarly, you can put your projector in standby mode by
following themanufacturer’s instructions included with your projector. To change the settings, see the
instructions included with your operating system.

Matching your computer’s resolution to your projector’s resolution
Ensure that the resolution settings for your projector and computer match. If your computer’s
resolution doesn’t match the projector’s native resolution, the image won’t appear correctly or will be
distorted. SeeGetting the Best ImageQuality on Your SMART Board InteractiveWhiteboard
(smarttech.com/kb/127199) for more information.

Determine your projector’s native resolution, indicated in your projector’s user’s guide, and then set
your computer’s resolution tomatch. You can change your computer’s resolution inWindows Control
Panel or in theMac System Preferences. If you need further help changing your computer’s
resolution, see the instructions included with your operating system.

Youmight also need to adjust your computer’s refresh rate to obtain the best results. Set the
computer to an initial refresh rate of 60 Hz, and then adjust this rate up or down until you determine
the ideal refresh rate. For more information on changing your computer’s refresh rate, see the
instructions included with your operating system.

CHA PT ER 3
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Calibrating your interactive whiteboard
Digital cameras in the corners of the interactive whiteboard track the position of the pens, eraser and
your finger on the interactive surface, and then send the information to the SMART software, which
interprets this information as mouse clicks, digital ink or ink removal in the appropriate location.

The first time you connect your interactive whiteboard interactive whiteboard, if you don’t see a pop-
up bubble telling you to calibrate the interactive whiteboard, press theHelp button on the pen tray to
start the calibration process as described below. This process ensures that the cameras accurately
track your finger and the pens on the interactive surface.

I   I MPORTANT

If you have not used your interactive whiteboard before, youmust perform a calibration. If the
system detects incorrect calibration parameters, a warning bubblemay also appear recommending
that you perform a calibration.

g To calibrate the interactive whiteboard

1. Click the SMART software icon in theWindows notification area or Mac Dock, and then click
Control Panel.

2. Select SMART Hardware Settings.

3. If you havemore than one SMART product connected, select the appropriate interactive
whiteboard.

4. Click Advanced Settings, and then click Calibrate.

TheCalibration window opens. This can take a few moments while your system sets up.

CHA PT ER 3
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5. Use the tip of a pen tray pen to press the red targets as they appear. Move the tip to the center
of each target until the target turns green, and then lift the pen. When you remove the pen, the
target moves to the next calibration point.

N   NOTE

You can re-calibrate a target by pressing the left arrow key on your keyboard, or the
Keyboard orRight-click buttons on the pen tray.

6. Continue until you have pressed all the targets.

When you’ve pressed all the targets, a message appears saying that the calibration was
successful, and then the orientation screen appears.

Orienting your interactive whiteboard
After you install SMART Product Drivers on your computer and calibrate your interactive whiteboard,
an orientation screen appears. The 4-point orientation process ensures that the calibration
coordinates are accurately associated with the relative location of your projected image on the
interactive surface. The orientation data is saved in your interactive whiteboard. If you connect a
different computer, the orientation data for your interactive whiteboard remains unchanged.

Orient your interactive whiteboard if your projector or interactive whiteboard has moved since you last
used it, or whenever themouse pointer isn’t properly aligned with your finger or a pen tray pen when
you touch the interactive whiteboard’s surface.

g To orient your interactive whiteboard

1. Press theOrientation button on the pen tray (seePowermodule buttons and indicators on
page 20).

The orientation screen appears.

2. Pick up a pen from the pen tray.

CHA PT ER 3
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3. Beginning at the upper-left corner of the screen, touch the center of the target firmly with the tip
of the pen. When you remove the pen, the target moves to the next orientation point. Try not to
flick the pen when you lift it from the interactive surface, andmake sure that you lift it from the
screen at a 90° angle.

N   NOTE

Although you can use your finger to orient your interactive whiteboard, a fine-point tool such
as a pen tray pen provides greater precision when touching the targets. Themore precisely
you touch the targets, themore accurately your finger or pen tray pen appears on the
interactive screen.

Good orientation point
The pen touches the center of the target

Poor orientation point

4. Repeat step 3 until you complete the orientation process.

The orientation screen closes.

N   NOTE

You can re-orient a target by pressing the left arrow key on your keyboard, or theKeyboard
orRight-click buttons on the pen tray.

CHA PT ER 3

Setting up your interactive whiteboard

17



Connecting a guest laptop
If you want to connect a guest laptop without installing SMART Product Drivers on it, disconnect the
USB cable from your resident computer, and then connect it to the laptop. You’ll immediately have
touch control of the interactive whiteboard, but won’t be able to use digital ink. You’ll also need to
connect a video cable between the laptop and projector.

N   NOTE

With a laptop connected, the Ready light on your interactive whiteboard blinks until you install
SMART Product Drivers. This is normal. SeePowermodule buttons and indicators on page 20 for
more information about Ready light states.

Youmust also install SMART Product Drivers (refer to page 13) on your laptop if you want to use all
the features of the interactive whiteboard.

CHA PT ER 3
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Getting started
Once you install your SMART Board 800 series interactive whiteboard and software and complete
the calibration and orientation, you can use the interactive whiteboard to write, erase andmove
objects, open applications, use Ink Aware programs and save your notes on your computer.

Turning your interactive whiteboard on and off
To start your interactive whiteboard, turn on your computer, turn on your projector, and then press the
Power button, which is the green light on the left side of the pen tray.

Each time you turn on your interactive whiteboard, the pen color buttons cycle twice, and then the
light comes on only for the ink color you select.

When your computer is on and the Power button is off, the interactive whiteboard is in Standby mode.
Press thePower button to wake up your interactive whiteboard. When you finish, press thePower
button again to return it to Standby mode.

Chapter 4
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Power module buttons and indicators
The Powermodule at the pen tray’s left side has Power, Orientation and Help buttons, as well as the
Ready light.

Power button
Press this button to put your interactive whiteboard into Standby mode when it isn’t in use, or to
restore full power to it when you need to use it. Ensure that the interactive whiteboard is connected to
your computer and to a wall power outlet.

Orientation button
Press this button to start the orientation process. Orienting your interactive whiteboard ensures that
themouse pointer or digital ink appears directly below your finger or pen tray tool when you touch the
interactive surface. Refer to page 16 for information on performing an orientation procedure.

Help button
Press this button to access on-screen Help options, including links to online Help files,
troubleshooting options and contact information for SMART support.

Ready light
This light indicates the status of the interactive whiteboard's controller module. The Ready light is
solid green when the system is working properly.
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The following table shows the Ready light’s normal states. If the indicator’s behavior doesn’t match a
state listed here, see Troubleshooting tips on page 33.

Ready Light State Meaning

Solid red Your interactive whiteboard is receiving power from the power cable, but
isn’t communicating with a computer.

Flashing green Your interactive whiteboard is receiving power and is communicating
successfully with your computer’s USB HID driver. SMART Product
Drivers isn’t installed.

N   NOTE

In HID mode, interactive whiteboard tools such as the pens and the
eraser don’t work, but you canmove themouse pointer and perform
mouse functions by touching the interactive surface. The Right-click
button on the pen tray might work, depending on the version of
operating system you’re using. Neither the Keyboard nor the Help
button work in HID mode.

Solid green Your interactive whiteboard is receiving power and is communicating
successfully with SMART Product Drivers.

Flashing amber The controller module is in a servicemode or the firmware is being
updated.
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Using the pen tray
In addition to providing a convenient place to hold the pens and the eraser, the pen tray on your
SMART Board 800 series interactive whiteboard has several controls, sensors and indicators.

Pen tray buttons
In the center of the pen tray, there are six buttons. Themiddle four change the color of digital ink for
the two pen tools. The buttons on either side of the pen color buttons default to the on-screen
keyboard (left button) and right-click (right button) functions.

You can customize your pen, eraser and button settings. For example, you can change line
transparency, color and style; you can change the width of the eraser; and you can change the
Keyboard and Right-Click button settings so that they perform another action.

N   NOTE

Pressing theKeyboard andRight-Click buttons simultaneously starts the orientation.
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Customizing your pen tray buttons
You can use the SMART control panel to customize your SMART hardware settings,

including the pen, eraser and button settings.

g To customize the button settings

1. Press the SMART software icon in theWindows notification area or Mac Dock, and then select
Control Panel.

The SMART control panel opens.

2. Press SMART Hardware Settings and select your SMART Board interactive whiteboard.

3. Press Pen and Button Settings from the drop-down list, and then select the button you want
to customize.

4. Follow the on-screen instructions.

For more information about customizing your settings, open the online Help by pressing theHelp
button on the pen tray, selectingHelp Center, and then selectingSMART Hardware Settings.

Using Ink Aware
Ink Aware integrates SMART software with applications such as Microsoft® Word, Excel® and
PowerPoint®. When you use an application that is Ink Aware, whatever you write or draw on your
interactive whiteboard becomes embedded in the file, rather than remaining as an external note
created over the file.

g To view a list of Ink Aware applications

1. Open the SMART control panel.

2. Press Configure SMART Tools.

3. Select Ink Aware Program Settings.

TheAware dialog box appears. You can enable or disable Ink Aware for any of the applications
in the list.
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Writing, selecting and erasing using object
awareness
Your SMART Board 800 series interactive whiteboard features object awareness, whichmeans you
can pick up a pen and write, select or erase without replacing the pen. SMART software interprets
your intent when you press the interactive surface, based on both the type of tool you’re using and the
size of the contact area.

l If you touch the interactive surface with the pen, SMART software identifies its reflective
surface, and you write or draw in digital ink on the screen.

l If you touch the interactive surface with your finger, you perform a left click.

l If you touch the interactive surface with an eraser, your palm or the side of your hand, SMART
software identifies a large contact area, and you erase digital ink from the screen.

Using Lockable Penmode
If you want any touch on the interactive whiteboard surface to register as a specific tool—such as a
pen, eraser, or Select tool—activate that tool and then, hold down a pen color button on the pen tray
until its light flashes (about three seconds). The interactive whiteboard locks into that mode.

EXAMPLE

If you want every touch to create red ink, press the red pen tray button until the red light flashes
(about three seconds). Then every time you touch the board with your fingers, a pen or an eraser,
you create red ink.

N   NOTE

The selected pen tray light blinks to indicate you’re in Lockable Penmode. To unlock the pen, press
any pen tray color button.
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Using gestures
Touch gestures enable you to use pre-determined commands without using the keyboard or mouse.
With a series of touches on your interactive whiteboard screen, you can navigate pages, change the
look of an object, erase digital ink andmore.

Before you use gestures, youmust enable your interactive whiteboard to recognize them. If you don’t
enable gestures, only single-finger gestures are enabled.

N   NOTES

l Gestures are enabled by default onWindows 7 operating systems andMac OS X 10.6 or
later operating system software.

l If gestures aren’t working as expected on yourWindows computer, try the following:

o Disable theWindows Flick and Single-Finger Pan gestures to improve the
performance of other gestures. For more information, see theMicrosoft website.

o Select Start > Control Panel > Administrative Tools > Computer Management >
Service, and ensure that the Tablet PC Input Service is running and starts
automatically.

o Select Start > Control Panel > System > Hardware > Device manager > Human
Interface Devices. If SMART Virtual Tablet PC driver (one of the
SMART Product Drivers) isn’t visible, remove SMART Product Drivers and then
install them again.

l Depending on which operating system and which application you’re working in, some
gestures might not work or could perform differently than described (see
smarttech.com/kb/144789).
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Single-finger gestures
When you install SMART software, you can perform some gestures using one finger, including
selecting objects and double-clicking.

You can also enable “flicks” onWindows 7 orWindows Vista® operating systems. To perform a flick,
press the screen, and then drag quickly in one direction before releasing your finger. Flicks perform
different actions depending on the direction of the flick, and can be customized to perform different
functions.

For more information on flicks, see theMicrosoft website:

l Windows 7 operating system: windows.microsoft.com/en-US/windows7/What-are-flicks

l Windows Vista operating system: windows.microsoft.com/en-US/windows-vista/What-are-
pen-flicks

Single-finger gestures include the following:

Selecting and deselecting an object (clicking)
Quickly press and release the interactive surface to select or deselect
an object or option. This performs a standardmouse click.

N   NOTE

This gesture starts programs if your operating system is set to start
applications on a single click.

Displaying menu options (right-clicking or control-clicking)
Press and hold the screen with your finger.
In SMART Notebook software, SMART Meeting Pro software,
Windows andMicrosoft Office programs, the right-click menu
appears.
In Mac operating system software, menu options appear.

Dragging an object, scroll bar or window
Press and hold an object or scroll bar on the screen. Keep your finger
on the screen and slowly move the object or scroll bar. When you
reach the position you want, release your finger.
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Double-clicking
Quickly press and release the interactive surface twice in the same
spot. This performs a standard double-click.

N   NOTE

This gesture starts programs if your operating system is set to start
applications on a double click.

Displaying the next and previous page
Press the screen, and then quickly press again directly to the right of
that point to display the next page.

Press the screen, and then quickly press again directly to the left of
that point to display the previous page.
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Multi-finger gestures
You can perform some gestures using two or more fingers, including scaling, scrolling and
manipulating objects. Multi-finger gestures include the following:

Displaying menu options (right-clicking or control-clicking)
Using two fingers on the same hand, press and hold the screen with your left finger and then to press
the screen once with your right finger.

Lift your left finger from the screen, and then select amenu item with any finger.

Enlarging an area or object
Use one finger on each hand to press in the center of the area or
object, and then drag your fingers away from each other.

Reducing the sale of an object
Use one finger on each hand to press the screen at opposite ends of
the area or object, and then drag your fingers toward each other.
This gesture either scales an object on a page, or the entire page,
depending on the application.

Scrolling horizontally or vertically
Use two fingers on the same hand to press and hold the screen.
Keeping your fingers on the screen, move up, down, left or right on the
page. Release your fingers when you’re satisfied with the view.
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Swiping to a different page
Press the screen with all four fingers on your hand, swipe your fingers
to the right to display the previous page or to the left to display the next
page, and then release your fingers.

Rotating an object
Place one finger on either side of the object you want to rotate. Keep
one finger stationary, and quickly move your second finger around the
object. Release your fingers from the screen when you’re satisfied
with the angle.
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Erasing digital ink
Using your flattened hand, palm, or fist, press the interactive surface
andmove your hand across the area you want to erase.

Use a scrubbingmotion to erase entire areas of digital ink.

Move your hand in a circle around the area you want to erase, and then
swipe your hand across themiddle of the circle to erase a large area of
ink.

Multitouch gestures
Two people are able to work together to draw, erase or interact with content anywhere on the
interactive surface at the same time.

Multitouch hand and finger gestures enable you to toss, rotate or zoom in or out on objects, and
interact within SMART software.

N   NOTE

Depending on which operating system and which application you’re working in, some gestures may
not work or may perform differently than described. Windows 7 operating system andMac 10.6
operating system software aremultitouch operating systems.
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Best practices for gestures and tools
Follow these guidelines when you use gestures and tools with your interactive product.

Hold your fingers perpendicular (90°) to the interactive surface at the contact point.

90°

90°

Keep your thumb and other fingers away from the interactive surface. They can generate
unintentional commands.
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Keep your other hand, elbows and loose clothing away from the interactive surface. They can
generate unintentional commands.

For “click” commands, quickly tap your finger on the interactive surface. Also, make sure you lift your
finger far enough away from the interactive surface between presses so that your finger is out of the
interactive whiteboard cameras’ view.

For “erase” commands, use your flattened hand, palm or the bottom of your fist.
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For “erase” commands, use your flattened hand, palm or the bottom of your fist.

When using the pen tray’s eraser, use the wide surface for large areas, and the smaller, angled
surface for smaller areas. Don’t use the edge of the eraser because this could be interpreted
incorrectly.
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Tips for trouble-free performance
l Connect your interactive whiteboard to a USB interface that’s recognized by the operating

system.

l Don’t obstruct the cameras’ view of the interactive whiteboard’s surface or edges. For
example, don’t placemagnets, stickers or adhesive tape on the interactive surface, or rest any
objects, including the pens, in the recess at the bottom of the interactive surface because this
interferes with the corner cameras’ ability to detect your finger or pen tray tools.

Safety tips for teachers
l Tell students not to look directly at the light beam from the projector. Instead, encourage them

to keep their backs to the projector when working at the interactive whiteboard. Before students
turn to face the class, they should take a step sideways, out of the projector’s beam.

l Make sure that you don’t look directly into the projector’s beam. Keep your back to the class
when you write over a projected image. Step to the side of your interactive whiteboard before
you turn to face the class.

l Tell your students not to touch the projector because it can become extremely hot during
normal operation.

l Don’t use a chair to increase a student’s reach. If your students are unable to reach the top of
the interactive whiteboard, youmight need to remount a wall-mounted unit at a lower position.
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Preventing damage to your interactive whiteboard
Although your SMART Board interactive whiteboard’s surface is very durable, take the following
precautions to prevent damage to the interactive surface and other components.

l Don’t set up and use your interactive whiteboard in an area with high levels of dust, humidity or
smoke.

l Don’t use sharp or pointed objects, such as ballpoint pens or pointers, as writing tools.

l Replace the pen nib when the nib wears out.

l Don’t use low-odor dry-erasemarkers because they can be very difficult to erase. Use
standard (high-odor) dry-erasemarkers that show awarning to use them only in well-ventilated
areas.

l Don’t use adhesive tape on the interactive surface.

l Don’t use abrasive erasers or harsh chemicals to clean your product.

l Don’t use compressed air to clean the interactive whiteboard’s cameras because the force of
the air could damage them.

Keeping the writing surface clean
With proper care, your SMART Board interactive whiteboard will provide years of trouble-free service.
Follow these tips to keep the interactive whiteboard’s surface clean:

l Don’t spray cleaner directly onto the interactive whiteboard’s surface. Instead, spray a light
amount of cleaner on a cloth and then gently wipe the interactive surface.

l Clean your interactive whiteboard at least every six months.

l Don’t allow excess cleaner to flow onto the frame’s reflective surfaces, or into the pen tray
slots.

l The digital cameras located in the corners of the frame are protected from dust and dirt by
windows. In extremely dusty environments, spray a household, alcohol-free glass cleaner,
such as Windex® cleaner, on a cotton swab and rub it gently on the windows. Don’t use
compressed air to clean the cameras.

I   I MPORTANT

o Turn your interactive whiteboard off before you clean it so that you do not scramble the
desktop icons or inadvertently activate applications when you wipe the interactive
surface.

o To view dirt or streaks more easily, set your projector to standby (lamp off) mode.
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Cleaning the pen tray
If the infrared sensors in the sides of the pen tools’ slots become obstructed by dirt, moisten a cotton
swab with a household alcohol-free glass cleaner, such as Windex, and then carefully clean the
infrared transmitter and receiver.
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Updating your SMART software
To update your SMART software, go to the SMART software download page or use
SMART Product Update (SPU).

g To check for software updates

1. Click the SMART software icon in theWindows notification area or theMac Dock, and then
select Check for Updates and Activation.

TheSMART Product Update dialog box appears listing the SMART software products
installed on your computer.

N   NOTE

If you don’t see theCheck for Updates and Activation option, contact your network
administrator.

2. Click theUpdate button beside the software you want to update.

Your SMART software updates automatically.

Adjusting the projected image
Alignment errors occur when the projected image isn't perpendicular to the screen. Alignment errors
can occur when youmount your interactive whiteboard on an uneven surface or a wall that has
obstructions, or if you position the projector too far from the vertical or horizontal center of your
interactive whiteboard.

If your projector isn't installed in a fixed location, you can correct many image problems by shifting
your projector or adjusting its alignment settings and zoom lens.

If you are using a SMART projector, refer to your interactive whiteboard system's user's guide.

N   NOTE

Adjust the image size and shape while projecting a full-screen image such as your projector’s
splash screen, unless the splash screen image is much smaller than the computer’s projected
image. Before you adjust the projected image, set the computer’s resolution and refresh rate (see
Configuring your computer settings on page 14).
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Resetting your interactive whiteboard
If your interactive whiteboard behaves erratically or becomes unresponsive, possibly because of an
electrostatic discharge, a power interruption or some other event, youmight be able to restore normal
operation by resetting your interactive whiteboard. This turns the power off and back on, restarting all
components of your interactive whiteboard.

g To reset your interactive whiteboard

Disconnect and then connect the power cable at the wall outlet.

OR

Press theReset button briefly (less than three seconds) on the bottom of the pen tray.

All the pen tray indicator lights flash sequentially twice and the interactive whiteboard resets.

I   I MPORTANT

If you accidentally press the Reset button for longer than three seconds, the interactive whiteboard
goes into a servicemode and the pen tray flashes amber. To get the interactive whiteboard out of
the servicemode, disconnect the power cable from the wall outlet, and then connect it again.

N   NOTE

The Reset button is recessed so that it can’t be triggered accidentally. Use a long, narrow object,
such as a ball-point pen, to press this button.

Using the Connection Wizard
You can resolvemany troubleshooting issues using the SMART ConnectionWizard found in the
SMART control panel.

g To start the SMART Connection wizard

1. Press theHelp button on the pen tray.

TheHelp and Support for Your SMART Board InteractiveWhiteboard window opens.
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2. Press Connection Wizard.

TheSMART ConnectionWizard opens.

T   T I P

You can also access the SMART ConnectionWizard by selecting the SMART software icon
in theWindows notification area or Mac Dock, selecting Control Panel, and then selecting
ConnectionWizard.

3. Select SMART Board 800 series interactive whiteboard, and then press Next.

4. Select the option that best describes the issue you’re encountering, and follow the on-screen
instructions to troubleshoot your interactive whiteboard.

Starting the troubleshooting process
The Ready light is on the pen tray’s left side beside the Help button. It indicates the status of the
controller module.

The Ready light is solid green when the system is working properly.

CHA PT ER 5

Troubleshooting your SMART Board 800 series interactive whiteboard

40



The following table shows the Ready light’s normal states.

If the Ready light
is...

The interactive whiteboard... Actions

Off Isn’t receiving power or is in
Standby mode.

l Press thePower button on the pen
tray to bring the interactive
whiteboard out of Standby mode.

l Ensure that the interactive
whiteboard is connected to a wall
outlet.

Solid green Is receiving power and is
communicating successfully with
SMART Product Drivers

Solid red Is receiving power from the power
cable but isn’t communicating
successfully with the computer.

l Ensure that the power cable is
connected properly to the
interactive whiteboard.

l Ensure that the interactive
whiteboard is connected properly to
the.computer using a USB cable.

l Ensure that the computer is on.

Flashing green l Is in HID mode. It’s
receiving power and is
communicating
successfully with your
computer’s USB HID
driver.

l SMART Product Drivers
isn’t installed.

This is normal mousemode and youmight
not want to use tools such as the pens and
the eraser. You’re able tomove themouse
pointer and perform mouse functions by
touching the interactive surface. The
Right-Click button on the pen tray might
work, depending on the operating system
you’re using. Neither the Keyboard nor the
Help button work in HID mode.

l To use the tools, install
SMART Product Drivers.

l To use all the features of your
interactive whiteboard, install
SMART software
(smarttech.com/software).

Flashing amber Is in a Servicemode or its
firmware is being updated.

Wait until the download finishes. After the
download is complete, the Ready light
turns solid green.
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Refer to this table for troubleshooting tips if the Ready light indicates that your interactive whiteboard
is working properly, but you’re still experiencing problems.

Symptoms Possible causes Actions
No image is projected
on your interactive
whiteboard, or a “No
Input” message
appears.

Your computer is in Standby
mode.

Move themouse or touch the interactive
surface or any key on the keyboard to bring
your computer out of Standby mode.

Your computer is off. Turn on your computer (or press your
computer’s reset button), and then log on as
usual.

The projector isn’t receiving a
video signal.

l Check the video cable connections.

l Ensure that the correct video input is
selected on the projector.

l Ensure that the projector is on and
that it’s connected to your computer
and a wall outlet.

l If you’re using a laptop computer, turn
on the external video connection.
Refer to your laptop’s user’s guide for
more information.

The orientation screen
doesn’t appear when
you press the
Orientation button.

The orientation screen is
appearing on a different
display.

Press theOrientation button again, or press
SPACEBAR on the keyboard until the
orientation screen appears. Alternatively,
open the SMART control panel and select
Orient/Align the SMART Product.

The projected image is
blurry, too large or
doesn’t completely fill
the interactive surface.

The projector’s position,
zoom and focus settings
aren’t adjusted.

Adjust the projector’s position, zoom and
focus settings. Refer to the projector’s
user’s guide for more information.

Your computer’s display
resolution settings don’t
match the projector’s native
resolution.

Refer to the projector’s user’s guide for the
correct display resolution, and then go to
Windows Control Panel or theMac System
Preferences to change your computer’s
display resolution tomatch the projector.

The SMART software
icon doesn’t appear in
theWindows
notification area or Mac
Dock.

SMART Board Tools isn’t
running.

Start SMART Board Tools.
ForWindows computers, select Start > All
Programs > SMART Technologies >
SMART Product Drivers > SMART
Board Tools.
For Mac computers, select Finder >
Applications > SMART Product Drivers
> SMART Board Tools.

SMART Product Drivers
aren’t installed.

Install SMART Product Drivers on your
computer (refer to Installing
SMART Product Drivers on page 13 ).
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Symptoms Possible causes Actions
There is a small red ×
on the SMART Board
icon.

SMART Product Drivers is
unable to detect your
interactive whiteboard.

Ensure that the USB cable is connected to
you computer and your interactive
whiteboard and that the cable isn’t longer
than 16' (5 m).

SMART Board software
service isn’t running.

Start SMART Board software service.

Touch isn’t accurate.
The pointer doesn’t
appear directly below
your finger. When you
write on the interactive
surface, your writing
appears at a slight
distance from the pen.

Your interactive whiteboard
isn’t oriented properly.

Orient your interactive whiteboard. To start
the orientation, press the Orientation button
on the pen tray (refer toOrienting your
interactive whiteboard on page 16).
If the Orientation screen doesn’t appear,
perform a calibration procedure. Refer to
Calibrating your interactive whiteboard on
page 15.

Digital ink doesn’t
appear on the
interactive whiteboard
or appears
intermittently.

The interactive whiteboard
isn’t calibrated properly.

Use SMART Board Diagnostics to confirm
the issue, and then perform a calibration
procedure. Refer toCalibrating your
interactive whiteboard on page 15.

Nothing happens when
you touch the
interactive whiteboard,
even though the
computer and projector
are on.

A camera is obscured. Remove any object attached to the
interactive surface or resting in the bottom
bezel behind the pen tray.

The interactive whiteboard is
off.

Press the Power button on the interactive
whiteboard’s pen tray to turn it on.

One of the pen color
buttons is flashing.

The interactive whiteboard is
in Lockable Penmode.

Press any pen tray button to exit Lockable
Penmode.

Ink always appears on
the screen, even when
you touch the
interactive surface with
a finger or the palm of
your hand.

A pen is missing from the
pen tray and Touch
Recognition has been
disabled.

Place all the pen tray tools in their slots and
press the Help button on the pen tray. Select
Touch Recognition Settings and ensure the
Enable Touch Recognition box is selected.

You have selected the
lockable pen option. See
page 24 for information.

Press any pen tray color button to exit the
lockable pen option.

An error message
appears when you try to
calibrate your
interactive whiteboard.

A camera isn’t properly
connected or isn’t functioning
correctly.

Contact SMART Technical Support .
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Troubleshooting using the Ready light
You can troubleshoot your interactive whiteboard using the Ready light, together with other
observable symptoms and behaviors. Before you start troubleshooting, seeStarting the
troubleshooting process on page 40 to locate the Ready light, and then familiarize yourself with its
states during normal operation. The following flowchart directs you to the next stage in your
troubleshooting process.

Flowchart 1: Getting started
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Flowchart 2: The Ready light is off

When the Ready light is off, the interactive whiteboard isn’t
receiving power.

Press theReset button on the bottom of the pen tray to reset
the interactive whiteboard. Alternatively, disconnect the power
cable at the wall outlet, and connect it again.

When you reset the interactive whiteboard, all the pen tray
lights flash sequentially twice, indicating successful
communication with the SC14 controller. If they flash
continuously, reset the interactive whiteboard again. If this
doesn’t solve the issue, youmight need to replace the pen tray.

Check that the power cable is connected to the correct
receptacle. The audio and power receptacles are located beside
each other on the back of the pen tray.
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Flowchart 3: The Ready light is solid red

A red Ready light indicates that the interactive whiteboard is
receiving power but isn’t communicating successfully with the
computer. In most cases, pen tray lights don’t turn on and the
screen doesn’t respond to touch.

The interactive whiteboard is connected to the computer with a
USB cable, and to the wall outlet with a power cable. You can
access these cables by reaching underneath the pen tray.

The USB cablemust not exceed 16' (5 m).

Press theReset button on the bottom of the pen tray to reset
the interactive whiteboard. Alternatively, disconnect the power
cable at the wall outlet, and connect it again.
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Flowchart 4: The Ready light is flashing green
This is the normal mousemode state when SMART Product Drivers isn’t installed on the computer.
This mode can be useful for occasional or guest users who don’t require the use of SMART Board
Tools or pen tray functions.

Before you can use SMART Board Tools or the pen tray pens and eraser, SMART Product Drivers
must be installed and running. If the SMART software icon doesn’t appear in theWindows notification
area or Mac Dock, youmust start SMART Product Drivers.

To use all the features of your SMART Board 800 series
interactive whiteboard, go to smarttech.com/downloads
to download and install SMART software.

To determine whether the SMART Board software
service is running, open the SMART control panel and
check themessage that appears at the bottom. Start
SMART Board software service.
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Flowchart 5: The Ready light is solid green but pen tray tools behave
unexpectedly

A solid green Ready light indicates that the
interactive whiteboard is working properly.
However, if the pen tray tools don’t work
as expected, use this flowchart to
troubleshoot the interactive whiteboard.

If another user has reassigned the pen,
eraser or button functions, the tools might
not work as expected. You can return them
to normal operation using the SMART
control panel to change SMART hardware
settings.

Use camera views to examine the images
reflected to the cameras from the inner
edge of the frame and to determine which
cameras are faulty (refer toChecking the
camera views on page 50).

Press theReset button on the bottom of
the pen tray to reset the interactive
whiteboard. Alternatively, disconnect the
power cable at the wall outlet, and connect
it again.

Calibrate the cameras to ensure that they
accurately track your fingers and the pens.

To update the firmware, run the SMART
Firmware Update application.
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Flowchart 6: The Ready light is solid green but the interactive whiteboard
isn’t responsive

Press theReset button on the bottom
of the pen tray to reset the interactive
whiteboard. Alternatively, disconnect
the power cable at the wall outlet, and
connect it again.

To check firmware versions, go to
SMART Board Diagnostics and then
select View > SBX800/SBID8070i
Bar > Version > Update. A table
appears listing the firmware version
currently running in each camera. If a
camera isn’t operating, you’ll see
zeros.

Use camera views to examine the
images reflected to the cameras from
the inner edge of the frame and to
determine which cameras are faulty
Refer toChecking the camera views
on the next page.

Calibrate the cameras to ensure that
they accurately track your fingers and
the pens Refer toCalibrating your
interactive whiteboard on page 15.

To update the firmware, run the
SMART Firmware Update application
(see Updating firmware).
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Troubleshooting using SMART Board
diagnostics
If you touch the interactive whiteboard’s surface and nothing happens, or if there is no digital ink or the
ink appears in some locations and not in others, use SMART Board Diagnostics to help identify and
resolve these issues.

I   I MPORTANT

Do not change diagnostic settings unless asked to do so by SMART Technical Support.

Checking the camera views
If nothing happens when you touch the interactive whiteboard surface, ensure that nothing is
obscuring any of the cameras’ views.

g To check camera views

1. Press the SMART software icon in theWindows notification area or Mac Dock, and then press
Control Panel.

The SMART control panel opens.

2. Select About Software and Product Support > Tools > Diagnostics.

TheSMART Board Diagnostics screen opens.

3. Select View > SBX800/SBID8070i Bar.

TheSBX800/SBID8070i bar appears.

4. Click View.

The camera view window appears.

N   NOTE

The bottom-left camera is Camera 0, the top-left camera is Camera 1, the top-right camera is
Camera 2 and the bottom-right camera is Camera 3.
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5. Click Update to show what each of the four cameras sees. This can take several moments.

Each bar represents a picture from a camera, and the number beside the bar tells you which
camera took the corresponding picture. This image shows normal camera views.

N   NOTE

If the image is too small, click 2x to double the image size.

6. If one of the cameras’ views remains black, the camera is obstructed or can’t locate the
reflective surface on the interactive whiteboard inner frame. This image is an example of a
camera view obscured by a pen or other object.

Check the camera lens and ensure that nothing is obstructing the view and that nothing is
affixed to the interactive surface.

7. Click Save Image and then save the file with your choice of file name and location.

T   T I P

It’s a good idea to save the file to the SMART Technologies folder. You can save the image
with the log file for future reference or to e-mail to your technical support representative.

Checking the interactive whiteboard's calibration
If digital ink appears only in certain areas when you write on the interactive whiteboard, or no ink
appears, the interactive whiteboard could be incorrectly calibrated. You can test the calibration using
SMART Board Diagnostics Tracker utility.

g To check the interactive whiteboard's calibration

1. Press the SMART software icon in theWindows notification area or Mac Dock, and then press
Control Panel.

The SMART control panel opens.

2. Select About Software and Product Support > Tools > Diagnostics.

TheSMART Board Diagnostics screen opens.

3. Select View > SBX800/SBID8070i Bar.

TheSBX800/SBID8070i bar appears.
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4. Click Tracker.

The screen becomes white.

5. Touch the interactive screen with a pen, finger or eraser.

6. Verify that the tracking rays overlap.

This image shows two contact points: a finger and an eraser.

7. If the rays don’t overlap, and the rays change from colored to black, calibrate the cameras (see
page 15).

N   NOTES

l If one or more of the lines don’t move or don’t appear, a camera is obstructed or isn’t working
properly.

l If intermittent black lines appear, a second object, such as your sleeve, is touching the
screen while you write.
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Finding more information
The Help Center contains links to a wide range of information, including procedures, concepts, help
with applications, SMART software tool descriptions, troubleshooting hints andmore.

Access the Help Center by pressing theHelp button on the pen tray. The Help button also provides
access to the orientation screen and SMART contact information. Alternatively, you can access the
Help Center from the SMART software icon in theWindows notification area or Mac Dock.

Contacting SMART Technical Support
SMART Technical Support welcomes your call. However, if you experience difficulty with your
SMART Board interactive whiteboard, youmight want to contact your local reseller first. Your reseller
can often resolve the issue without delay.

You can find a list of parts and service parts diagrams for you interactive whiteboard or interactive
whiteboard system on the SMART support website (smarttech.com/support). To order parts, contact
your local reseller (smarttech.com/where).

Before contacting SMART Technical Support, make note of your SMART Board interactive
whiteboard’s serial number, and then note it in the inside cover of this manual (if you printed it).

g To determine your interactive whiteboard’s serial number

You can find the serial number in two places: on the back of your SMART Board interactive
whiteboard, and on the bottom right-hand edge of your interactive whiteboard’s frame (the side).
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The serial number on your SMART Board interactive whiteboard always begins with the letters SBX,
followed by the interactive whiteboard’s model number, for example, SBX880-xx-xxxxxx. The serial
number can include numbers, letters and hyphens.

N   NOTE

Make sure you include all the numbers, letters and hyphens in your serial number when contacting
technical support.

Transporting your interactive whiteboard
Save your original SMART Board 800 series interactive whiteboard packaging so that it’s available if
you need to transport your interactive whiteboard. When required, repack it with as much of the
original packaging as possible. This packaging was designed to provide optimal shock and vibration
protection. If your original packaging is no longer available, you can purchase the same packaging
directly from your authorized SMART reseller (smarttech.com/where).

If you prefer to use your own packagingmaterials, make sure you adequately protect your unit. Ship
you interactive whiteboard in an upright position to deter shippers from placing heavy objects on it.

Removing the pen tray
It might be necessary to remove the pen tray when you transport or service your interactive
whiteboard.

C   CAUT ION

There are no user-serviceable parts inside the pen tray. Do not disassemble the pen tray. If dust or
small items becomewedged in the spaces around the buttons, preventing them from being pressed
or causing constant button contact, remove the obstruction carefully.

N   NOTE

Electrostatic discharge (ESD) protection isn’t required when performing the following procedure.

g To remove the pen tray

1. Turn off your interactive whiteboard and disconnect the cables from the pen tray by
disconnecting the power cable from the wall outlet and the USB cable from your computer.

2. Remove the pens and the eraser from the pen tray.

3. Reach under the pen tray and disconnect the USB cable.
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4. If you secured the pen tray to its brackets using two security screws, remove the screws, and
then set them aside.

5. If you secured the pen tray using a Kensington lock or similar device, unlock and remove the
lock.

6. Reach under the pen tray and pull down on the two large plastic clips. Because the ends of
these clips project slightly downwards, they’re easy to locate.

7. While applying downward pressure to the clips, gently slide the pen tray toward you until you
can access the cables attached to the back of the pen tray.

8. Carefully disconnect these cables before completely removing the pen tray from the two L-
shapedmetal brackets.

To reinstall the pen tray, simply reverse these steps. When you replace the pen tray on its supports,
you’ll hear a click when it slides into place.
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Appendix A: Hardware environmental
compliance
SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment
sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies
products, we strongly encourage you to properly recycle the electronic product when it has reached
end of its life. If you require further information, please contact your reseller or SMART Technologies
for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances
(RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas, and that reference the European Union’s RoHS directive.

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The
packaging used by SMART Technologies to ship products complies with applicable packaging laws.
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China’s Electronic Information Products
regulations
China regulates products that are classified as EIP (Electronic Information Products).
SMART Technologies products fall under this classification andmeet the requirements for China’s
EIP regulations.

U.S.Consumer Product Safety Improvement Act
The United States has enacted theConsumer Product Safety Improvement Act which limits the lead
(Pb) content in products used by children. SMART Technologies is committed to complying with this
initiative.
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